Informed Delivery® B rostar service.

INTERACTIVE CAMPAIGN IMAGE REQUIREMENTS

Ride-along Image

E.COMING TO YOUR MAILBOX SOON. USPS®requires that Informed Delivery Interactive
Campaigns include full color interactive content that
displays alongside the package tracking details in the
Scanned Image Digest and Dashboard. When users select the Ride-
along Image, visible in a daily digest email or on the
Retailer Uane dashboard, they are redirected to the target URL.

View all mail on dashboard >

-» - This supplemental content is meant to enhance the package
tracking experience for consumers. For optimal quality within
the digital setting, follow the recommendations and
requirements below:

Customerame *  Sync the look of the Ride-along Image to the mailpiece or
ChysStmea 7P e Representative Image presented.

DISCOUNT APPLIES TO AL FULL-PRICE SEASONAL ITEMS LOREM IPSUM DOLAR.

+ Treatthe Ride-alongImage like a branded, clickable button
with a clear call-to-action.

*  Optfora clean, simple layout.
Kéfailer Uawe > *  Provide a direct URL (must start with https).

Targeted message derail

+ Target URL must lead directly to a landing page
associated with the physical mailpiece.

K ) *  Size to atleast one maximum dimension: 300px width or
Ride-along Image 200pxheight.

SHOP THIS SALE ©

i‘ﬁfﬁ?pf AT ST e L Reverse type on solid color is
e 3 .
Angorty, ST 12385 Ir_gig]?orces clean and legible

Grandwe brand

723% W, Sampte K.
Agtaan, ST 712375

> Ketailer Uame

Targeted message detail 200px
Required > SHOP THIS SALE ©
» Save file as a JPEG(.jpg) 1
*  File cannot exceed 200KB in size Lmerignd ' ' .
ge 300px Call-to-action

» Image color code must be RGB (not CMYK) sync to is clear and

mailpiece compelling

Try to avoid:
x Plain text % Logo only % Imageonly
Visit our website >
Wawme
Lacks customized branding Unclear that contentis clickable No call to action

“RetailerName” is not an actual company and is for illustrative purposesonly. 3.2022
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Representative Image

5= COMING TO YOUR MAILBOX SOON.

View all mail on dashboard »

f Representativelmage

Use promo code
TAKE3Q
at checkout

FROM Retailer Name

Rérﬁuﬂ' 'Aa‘{ke Learn Mor>e

Targeted message detail

SHOP THIS SALE ©

: e
are Grandlil ANVCITY ST M2 T g
678 Fietimal P,

Argeity, ST 12345

‘fmd«a
7232 W, Sunple K.
Fngtawn, ST 12345

Try to avoid: x

Correlation to mailpiece is lost

“Retailer Name” is not an actual company and is for illustrative purposes only.

Lacks mailpiece details

USPS®allows you to enhance your Informed Delivery
campaign with a full color image that displays in place of
the scanned mailpiece (i.e., letters and postcards). Users
can view this content in a daily digest email or on their
dashboard.

Don’t miss an opportunity to use the production art created
for your mail campaign. For optimal quality within the digital
setting, follow the below recommendations and
requirements.

» Use a color image of the mailpiece so userscorrelate
the digital image.
Note: The image must be branded and directly related to the
mailpiece and its contents.

»  Syncthe look of the Representative and Ride-
along Images to each other for a cohesive
experience.

» Size to atleast one maximum dimension: 780px width
or 500pxheight.

Color image of the mailpiece

500px
max
! height
Use pramo code
TAKE30
at (he(knt
780px maxwidth
Look and feel match K Use at least one
the Ride-alongImage maximum image

parameter
Required:

» Save file as a JPEG(.jpg)
*  File cannot exceed 200KB in size
* Image color code must be RGB (not CMYK)

Grayscale

Lacks customized branding
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Informed Delivery®

INTERACTIVE CAMPAIGN IMAGE REQUIREMENTS

™ UNITED STATES
F POSTAL SERVICE o

Representative Image - Flats

B2 COMING TO YOUR MAILBOX SOON.

View all mail on dashboard »

/_ Representativelmage

tashion
secrets
1o wear
now!

w

FROM Retailer Name

Relgiler Uame

Targeted message detall

Learn More >

SHOP THIS SALE ©

k Ride-alonglmage

; — e
Jm?‘m/f; o AMNCITY ST 812 @’ oy
678 [ ietivne 4 =

Argority, ST 72345

4‘mdna
7234 W, Sample KY.

Augtown, ST 12345

Try to avoid:

Correlation to mailpiece is lost

“Retailer Name” is not an actual company and is for illustrative purposes only.

X Lacks mailpiece details

USPS®requires you to conduct an Informed Delivery
campaign using a full color image in lieu of your mailpiece
(i.e., catalogs and magazines). Users can view this content in
a daily digest email or on their dashboard.

Don’t miss an opportunity to use the cover art created

for your latest mailing in a digital preview of incoming mail.

For optimal quality within the digital setting:

» Use a color image of the mailpiece so userscorrelate
the digital image.

Note: The image must be branded and directly related to the
mailpiece and its contents.

»  Syncthe look of the Representative and Ride-
along Images to each other for a cohesive
experience.

» Size to atleast one maximum dimension: 780px width
or 500pxheight.

Color image of the mailpiece

500px
max
height
780px max
Look and feel match width & Use at least one
the Ride-along Image maximum image

parameter
Required:
«  Save file as a JPEG(.jpg)

»  File cannot exceed 200KB in size
* Image color code must be RGB (not CMYK)

%X Grayscale

3.2022
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Need Help?
Verifying Image Dimensions

To determine whether a Ride-along Image meets the size requirements, follow the steps below.
1. Make a copy: Create a copy of your image file so you do not lose theoriginal.

2. Openimage in Paint: Right click on the imagefile, select “Open with,” and select “Paint” from the options provided.

Open with > | @b Paint «

Give access to > H Paint 3D
I WinZip s | Ml Photos
Restore previous versions " Snip & Sketch
Send to > - Search the Microsoft Store
Choose another app
Conv

3. Select the entire image: Select the entire image by pressing CTRL + A or by clicking the “Select” button in the
Home tab and choosing “Select all.” You will see a dashed line appear around the edge of the image.

4. Clickthe “Resize” button: You can find the “Resize” button in the Home tab or by pressing CTRL + W. This will
open the “Resize and Skew” window.

@ H = | Untitled - Paint
| Home View
m bocor T 5 A ‘ (d N/ OO« [7 outline
copy | & Resize h | &ABQC\ - Fill
e Ao ¥ /RS OB OG0
Clipboard Image Tools Shapes

5. Verify image dimensions: Select “Pixels” next to the By field. The image dimensions should appear. Horizontal
corresponds to width and vertical corresponds to height.

Resize and Skew *

Resize
(@) Pixels Ride-along Image:

By: (O Percentage
. J Horizontal cannot exceed 300px

+—*

|:| Horizontal: 1563

DI Vertical: 614
Does your image exceed Ride-along Image:

size requirements? Maintain aspect ratio Vertical cannot exceed 200px

Follow the steps on the
next page to learn how to
resize yourimages...

3.2022
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1. Make a copy: Create a copy of your image file so you do not lose theoriginal.

“Maintain aspect ratio”
ensures the image is not
distorted when resizing.

S

Resize and Skew

Resize

By: @) Percentage
+—r

|:| Horizontal:

[T et

D Maintain aspect ratio

(® Pixels

210

140

X

To resize a Ride-along Image that does not meet the size requirements, follow the steps below. Steps 1-4 are the
same as the “Verifying Image Dimensions” steps.

2. Openimage in Paint: Right click on the image file, select “Open with,” and select “Paint” from the options provided.

3. Select the entire image: Select the entire image by pressing CTRL + A or by clicking the “Select” button in the
Home tab and choosing “Select all.” You'll see a dashedline appear around the edge of the image.

4. Clickthe “Resize” button: You can find the “Resize” button in the Home tab or by pressing CTRL + W. This will
open the “Resize and Skew” window.

5. Use the “Resize” fields to change the size of the image: Change the size by typing in the new pixel size (values)
desired. Important Note: Making an image larger than the original will result in a lower-quality picture. Leaving the
“Maintain aspect ratio” option selected ensures the image is not distorted.

Type in the new pixel size that is
within the size requirements for
the Ride-along Image.

6. Click “OK?” to see your resized image: The image will be resized according to the values you entered.

7. Removethe excess canvas: The image will be resized, but the white canvas it is on will stay the original size.
+ Click and drag the edges of the canvas to resize it (see below), which removes the excess white space.
* Or, use the “Crop” function in the Home tab to remove the extra canvas. Press CTRL + A to select the entire
imageto start. Then, select “Crop,” click and drag to highlight only the area around the resized image, and select
“Crop” again. The excess white space should disappear, and the canvas should match the resized image.

‘campaigns

8. Save the resized image: Once the image is resized (and you confirm the size requirements are met), save the file.
Select “Save As” from the File tab and choose “JPEG picture.” Then, name the file and choose where you want to

save it.

3.2022
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INTERACTIVE CAMPAIGN IMAGE REQUIREMENTS

Need Help?
Resizing Images - Option 2

To resize a Ride-along Image that does not meet the size requirements, follow the steps below. Steps 1-4 are the
same as the “Verifying Image Dimensions” steps.

1. Make a copy: Create a copy of your image file so you do not lose theoriginal.

2. Visit an image resizing website: Search “resize jpeg” to find a variety of websites that will help you resize images
for free.

3. Upload the JPEG file you want to resize: Select and upload the file you want to resize.

the image size. Options include clicking and dragging a box, using sliders to adjust the size, or entering the exact
pixel dimensions. When possible, enter the exact pixel dimensions desired and click “Save” or “Resize image.”
Important Note: Making an image larger than the original will result in a lower-quality picture. To avoid losing quality,
maintain the aspect ratio.

5. Download the resized image: Once you resize your image, save the changes to the file. Select “Save As” and
choose “JPEG picture.” Then name the file and choose where to saveit.

4. Use the resizing controls to change the size of the image: Each website has a different set of controls to adjust

3.2022
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Tips to Determine Color Code

5.

To determine the color code of a Ride-along Image, follow the steps below.

Make a copy: Create a copy of your image file so you do not lose the original.

Convert the image to a PDF: Locate the image file on your computer and right click on the file. Select the “Convert

to PDF” option.

Navigate to Print Production: Locate the tool bar that lists “Home,” “Tools,” and “Document.” Select “Tools” and
scrolluntil you find “Print Production.” Select this option. Important Note: The location of the “Print Production” option

may differ depending on the application you are using.

Home Tools pocument

Ql

Pratect Fill & Sign Prepare Farm

Stamp Compare Documents Send for Comments

Combine Files

Action Wizard

€3: Output Preview

Preview color separations and color warnings; test different
color profiles and examine objects on the page

% Edit Object

/

Optimize PDF

Create Custom Tool

Simulate

Simulation Profile:

Redact

2]

Print Production

Qutput Preview

Simulate Overprinting

[] simulate Paper Color

[ simulate Black Ink

Show
Show:

[] show|

ﬁ Preview:

Don’t see a change after selecting “RGB”?
This means that your image is in the required
color code and does not need to be reformatted.

(Optional) Reformat image: If the image contains CMYK elements, the image owner will need to convert the color
code to RGB before the image can be used for an interactive campaign. Official image editing software may be

required to convert color code.

Separatiol

K K K K ]

U.S. Web Coated (SWOP) v2

Page has Overprint: No

[[] set Page Background Color

Ink Manager

All

‘Warning Opacity:

DeviceN
CMYK

RGB
DeviceRGB
ICCBased RGB
Gray
DeviceGray
CalGray
Calibrated
Lab

et Page Boxes

4. Verify color code: Identify and select “Output Preview” from the menu. On the pop-up menu that appears, under the
“Show” drop down, select RGB. If the image contains CMYK (Cyan Magenta Yellow Black) elements, these
elements will disappear from the image. If there are no CMYK elements, there will be no change to the image.

100

%

Process Magenta
Process Yellow
Pracess Black

Total Area Coverage

30%
0%
0%
94%
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